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Obijetivo: Utilizar o display de 7 segmentos do PLD para uma simples
contagem de 0 a 9 utilizando um decodificador 7448.

DISPLAY DE 7 SEGMENTOS
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Objetivo: Utilizar o display de 7 segmentos do PLD para uma simples
contagem de 0 a 9 utilizando um decodificador 7448.

O display de sete segmentos, é formado por sete leds, dispostos em
forma de oito. Quando se necessita de acenderonimero “0”, ligam-se os
leds correspondentesao digito “0”, por exemplo, os segmentos a, b, ¢, d,

e,f.
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Um dispositivo electréonico muito usado com os displays de 7 segmentos é o
descodificador BCD-7segmentos. O descodificadortem a funcéo de
interpretarum codigo (BCD) e gerar os sinais para ligar o digito
correspondente a este codigo no display de 7 segmentos.

Porexemplo:
Entrada do descodificadorem BCD (Decimal Codificado em Binario)— 0000
Saida do descodificadorpara o display de 7 segmentos -0111111-gfedch

a
0
0 ] 1 Saidado

Entrada do o Descodificador 1 descodificador para

descodificador BCD - 7segmentos 1 4 display de 7
1

(0 em BCD) 0 1
1

segmentos (digito 0) [_I

Note que a saida do descodificador corresponde a ligar os segmentos do
digito “0" de um display do tipo catodo comum.

Os descodificadores comerciais disponiveis sdo: 7447 (dnodo comum) e
7448 (catodo comum).

Descodificader BCD - 7 segmentos. d -

Circuito integrado 7448 D gmemos € =3l bispLA
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Passo a passo

Iniciar um Novo Projeto

Para comecar a trabalhar em um projeto novo, primeiro temos que definir um
escopo para este projeto. O “software” Quartus |l facilita esta tarefa

fornecendo suporte na forma de um Assistente (“Wizard”). A criagdo de
um Novo Projeto segue as etapas detalhadas a seguir.

a) Selecionar File > New Project Wizard para iniciar o Assistente de Novo
Projeto o qual direciona a criacdo e configuragfes preliminares de um Novo
Projeto.

b) Na janela “New Project Wizard: Introduction” , clicar em Next.

! Kioron
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Janela “New Project Wizard: Add Files”. O Assistente de Novo Projeto
permite incluir arquivos pré-existentes (se houver) no Projeto.

Mew Projoct Wizard: Add Files [page 2 af 5] [S5=)

Seleat e deior il pou werk toincluds i e poject ChekAdd Al 10 23 o design e in e
et diaeions o ha progact. Mola: you can akusye 20 desgn e b #a pojeel Gle

Bienams | [l add

= rame Type Desgn HOL verson

add Al
_u |

.
Specilp the path names of any non-defeul Brarie: Lget Lieagies
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Na janela “New Project Wizard: Family & Device Settings”:

f.1) Especificar o tipo de dispositivo no qual o circuito projetado sera
implementado.

No campo “Device Family — Family:”, escolher Ciclone IVE como Familia do
dispositivo de destino.

f.2) Pode-se deixar o “software” Quartus Il selecionar um dispositivo especifico
na familia, ou podemos escolher o dispositivo explicitamente. Utilizaremos esta
Ultima abordagem

No campo “Target device” escolher a opgao “Specific device selected in
‘Available devices’ list”.

f.3) No campo “Available devices” aparece uma lista de dispositivos
disponiveis, escolher o dispositivo denominado * que éum
PLD utilizado na Placa Didatica de Desenvolvimei

’ Kioron
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Family & Device Settings [page 3 of 5]

&4 New Project Wizard

Select the family and device you want to target for compilation.
You can install additional device suppart with the Install Devices command on the Tools menu.

To determine the version of the Quartus II software in which your target device is supported, refer to the Device Support List webpage.

Device family Show in 'Avaliable devices' list
Family: |Cydone Iv E - Package: [Any = ]
Devices: [Al ~ | Pincount: [any B3|
Target device Core Speed prade: [Any =
() Auto device selected by the Fitter Mame filter:
@ Specific device selected in "Available devices' list Show advanced devices
Other: nfa

Avaiable devices:

MName Core Voltage LEs User 1/0s Memory Bits Embedded multiplier 9-bit elements PLL +
EP4CE7SF2317 L 75408 293 2810880 400 4
EP4CE75F23I8L Lov 75408 293 2810880 400 4
EP4CE75F29C8 1.2V 75408 427 2810880 400 4
lEpacezsFaocy v [7sws ey lsmsso a0 ||
EP4CE75F29C8 L 75408 427 2810880 400 4
EP4CE75F29C8L Lov 75408 427 2810880 400 4
EP4CE75F29CSL Lov 75408 427 2810880 400 4 ‘_‘
EP4CE7SF2917 L 75408 427 2810880 400 4 I
EP4CE75F2918L 1oV 75408 427 2810880 400 4 ~
4 I »

<Back | [ Mext> |[ Finsh |[ cancel |[ heb |
i¢
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Resumo das Configuracdes escolhidas:

I R e A
New Project Wizard
4 New rect Waar

- -

Summary [page 5 of 5]

Project directory
Project name:
Toplevel design entity:
Number of fils added:
Number of user ibraries acded:
Device assignments:
Famiy name:
Device:
EDA tools:

Design entry/synthesis:

When you dick Finish, the project wil be created with the following settings:

C:\altera\14.0
aulal

aual

0

0

Cydone v &
EP4CETSF29C7

<None (<None>)

Simuiations ModelSim-Altera (VHDL)
Timing analysis: 0
Operating conitions:
VCCINT voltage: R
Juncton temperature range: o085 C
| | e [ .

Y
Aula 4

€ QuartusI64-8it- Cvaltera/140/aulsl ~aulal W e

File  Edit

&

View Project Assignments Processing Tools Window Hep 5

T TR IR S E% e

Project Navigator 18 x

/A Cydone IV E: EPACE7SF29CT
> aulal &

Entity

o Hierarchy

Files I ;?Deilﬂ

[Tasks ra x|
Flow: I" '] [Cusinm'ze...]
Task

4 Compile Design
b Analysis & Synthesis
I> B Fitter (Place &Route]

QUARTUS® Il SOFTWARE v13.1:
GET THE COMPETITIVE EDGE WITH TH;
A O
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Para descrever o circuito no formato de Captura de Esquematico deve-se uwsar o Editor
Grafico do Quartus IL conforme as etapas detalhadas a seguir.

a)  Selecionar File > New para obter a janela da Figwa 14. Escolher “Block Diagram /
Schematic File” e clicar em OK. Isso abre a janela do Editor Grafico (Figural5).

+ it Qv || Poject
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2+ Desun fiks
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-EDIFFis
State Wachies Fie
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Tel i Fle
Vi HEL Fis

| -WHOLFie
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Havadecinal nlelFoma) Fil

- My I izaimFie

& Verbeolen Tieboggig Fle:

s S0 Pl
Logo Anakess Irieifase Fie
SigpalTap | Lacic Anabyocs Fla

- Vecho Waveom Fis

= Over Fiss

LIk Pl

- Black Symkol e

Chein Descriion Fie
S Duegn Coresrske: Pl
Ter Fie

[ ] e |

2|
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# Project Directory
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* Interface Protoceis
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@ sexrch for Partne

by [E 70D
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meiro passo é especificar um nome para o arquivo que serd eriado. Selecionar File

> Save as ... que abre a caixa de didlogo mostrada na Figura 16.

b.1)

No campo “tipo:” a opgdo Block Diagram/Schematic File (*. bdf) deve estar
selecionada.

O campo “name:” deve conter o nome do arquivo. o mesmo nome dado ao
arquivo que foi especificado quando o projeto fot criado.

A opgdo “Add file to current Project™ deve estar selecionada.

Clicar em “Salvar’. o que armazena o arquivo no diretdrio
C:\Alunosldula_02\Nome 122100010 ¢ leva a jancla do Editor Grafico exibida
na Figura 17.

G oot =)
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= FS
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Home =]
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IETT TR L2 1 T LI 2 LA X WL
[T — L] Skt o —

- JADE-OTITANNSOON Y |

Ay Cydore IV E: EPACEIF2CT — - -

> adal

4 B Comple Desgn
B Ansiysis &Synthess
B Fitter (Place & Route)

# TimeQuest Teming Anclyss
e EDA Hasist Writer

s esarcy | E|rles | Foed|n

Tadks a8x i
Flow: | Complation = | [ customae... || ©
Tesk

1 Assentier (Generate prog] | *

W Progran Davics (CpenPrograd |

Editor Grafico

Interface Protocdls
* Memory Interfaces and Contralers
 Processers and Peripherals

Basc Functns

# tibrory
Barra de ferramentas o
da janela do e Intetace Protocds

* Memory Interfoces and Controlers
@ sexrch for Partne

o i v b A

oA EE 7= - |
#lype 1D  Message
b +]
4 \ Systen /\ Proseseng / |
16 kroton<

paixdo por educar

23/03/2015



L N

L N

y 4
Aula 4

O Editor Gréfico oferece uma série de bibliotecas que incluem elementos
de circuito que podem ser importados para um esquematico. Dé um duplo
cligue no espago em branco na janela do Editor Gréfico, ou clique no
icone na barra de ferramentas que se parece com uma porta AND .

1r

Va em “libraries”, em seguida, expandir a biblioteca “primitives”,
seguido de expansdo da biblioteca “logic” que compreende as portas
I6gicas. Selecione “and2”, que é uma Porta E de duas entradas, e clique
em OK. Agora, o simbolo da Porta E aparecera na janela do Editor
Gréfico. Usando o mouse, mova o simbolo para um local conveniente e
clique para colocéa-lo Ia. Importar a segunda

&
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No PLD construir um conversor 7448 com as saidas para o display de 7
segmentos. New- Block Diagram- C:/ Altera — Others- 7448

Utilizar 4 chaves! Chama-las de Entl, Ent2, Ent3 e Ent4.

ClEm 7448 S
= pu s F OA —————————
g B OB 0
Ewm ¢ OC —————: .:
. : ] oD —

3X——333333333§—CLTN o INECEEREREREREICHES
RESEEEEERED (it 4 IEEERREERRRRIO
EESEEREERED: i b S RTTERTRTTIOI

kroton*
. 4o
Aula 4
No PLD construir um conversor 7448 com as saidas para o display de 7
segmentos.
“ kroton*
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No PLD construir um conversor 7448 com as saidas para o display de 7
segmentos.

Ap6és isso, compile e comece a
conectar as entradas e saidas.

Utilizar as chaves SW0 — SW1-
SW2- SW3

E o 1° display.

Consultar a partir da pagina 36
do manual.

74
21 kroton®
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Compilar o Circuito Projetado

O arquivo do diagrama esquematico descrito — Luzes_de_Alerta.bdf, sera
processado por varias ferramentas do Quartus Il que irdo analisar o arquivo,
sintetizar o circuito, e gerar uma implementagéo deste circuito para o chip de
destino. Estas ferramentas sao controladas pelo programa aplicativo chamado
Compilador.

Para executar o Compilador selecionar Processing > Start Compilation, ou
clicar no icone da barra de ferramentas horizontal.

-

A medida que a compilagéo passa pelos varios estagios, seu progresso
é relatado em uma janela no lado esquerdo da tela do Quartus Il (janela
“Tasks”). O sucesso (ou insucesso) do processo de compilagdo é
indicado em uma caixa de diélogo,

22 ‘kl’(‘)tOf\I(
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1 - aulal -
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Atribuic&o de Pinos do PLD w

Assignments > Pin Planner
@W:- W Sistemas Digitais I Aula 3 final

o Insen w-‘wm“,‘m“m Rewsio  Bxibicdo

‘."‘Vvinnum»cw,nwmww-m-ﬂ . ’4 - a5

VB e on vew Procmng. Toos vawow e B ot

5 oo a8 Top View- WreBend
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| <conemgme>>
2
a2 ,
9 =
x
o 1 L ]
' .
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] T ety P Parring... & P
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wm‘ ‘ % Chave Jgricao Trout
%4 Led_Ginto. Output
4 Led Ports Output
% Sensoe_Gnto Trput
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=)« i 1 '
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Atribuicdo de Pinos do PLD

Assignments > Pin Planner

Pag. 38 do Manual

y 4
Aula 4

HEXO[3]

HEXO[6]

Figure 4-10 Connections between the 7-segment display HEX0 and Cyclone IV E FPGA

Table 4-4 Pin Assignments for 7-segment Displays

2 kroton®
. 4
Table 4-4 Pin Assignments for 7-segment Displays
Signal Name FPGA Pin No. Description I/O Standard
HEXO0[0] PIN_G18 Seven Segment Digit 0[0] 2.5V
HEXO0[1] PIN_F22 Seven Segment Digit 0[1] 2.5V
HEXO0[2] PIN_E17 Seven Segment Digit 0[2] 2.5V
/ANO[S RYA\
HEXO0[3] PIN_L26 Seven Segment Digit 0[3] Depending on JP7
HEXO0[4] PIN_L25 Seven Segment Digit 0[4] Depending on JP7
HEXO0[5] PIN_J22 Seven Segment Digit 0[5] Depending on JP7
HEXO0[6] PIN_H22 Seven Segment Digit 0[6] Depending on JP7
HEX1[0] PIN_M24 Seven Segment Digit 1[0] Depending on JP7
HEX1[1] PIN_Y22 Seven Segment Digit 1[1] Depending on JP7
HEX1[2] PIN_W21 Seven Segment Digit 1[2] Depending on JP7
HEX1[3] PIN_W22 Seven Segment Digit 1[3] Depending on JP7
HEX1[4] PIN_W25 Seven Segment Digit 1[4] Depending on JP7
HEX1[5] PIN_U23 Seven Segment Digit 1[5] Depending on JP7
HEX1[6] PIN_U24 Seven Segment Digit 1[6] Depending on JP7
HEX2[0] PIN_AA25 Seven Segment Digit 2[0] Depending on JP7
HEX2[1] PIN_AA26 Seven Segment Digit 2[1] Depending on JP7
26 i¢
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Atribuicdo de Pinos do PLD

Assignments > Assignment Editor

Jeskiop/Teste/aulal - sl bt s S i - W

Processing  Tools  Window Help )

[auaz JHEY EFe O e OO 0P A

- | 4 compiation Report -auia1 [ | auiatbdf 0| ¥ Asomenteior 0 |

<<new>> v [J]Filter on node names: * - Catsgo(y:[ﬂ -
it From To Assignment Name Value Enabled Entity Comment Tag

1 in_ Sensor_Porta  Location PIN_Y23 Yes

2 I ', sensor_Cinto  Location PIN_Y24 Yes

3 I . Cheve..nicao  Location PIN_AAZ2 Yes

4+ [ 24 fsensor_Ginto Location PIN_H15 Yes

5 « N ° Led Ports  Location PIN_G15 Yes

5 « I 2% Led_Cinto Location PIN_F15 Yes

7 « [ 22 Alarme Locaton PIN_H17 Yes

8 <<new>> <<new>> <<NEW>>

kroton“
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Programacéo do PLD

Va em Tools > Programmer > Hardware Setup > USB- Blaster [USB-0]
e add o arquivo. sof

 Programmer - C/Users/Critiana/D aulal” [Craind.ce T e
Fle Edt View Processng Took Window Hep ) Search altera.com (]
2, Hardware Setup... | No Hardware Mode: [ITAG v Progress:
ble real-ime ISP to MAX IT and MAX V devices)
— Fie Device Checksum  Usercode  Program/  Verfy  Bark  Examine
ol start Canfigure Check

e
[ Auto Detect |
[ Xocete |
| save Fie
[ ome
[ Pooom |

kroton“
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Programacédo do PLD

Apo6s isso clique em start e acompanhe o progresso

W Prog CUsers/Cristiano/D: ~ aulal " [Chain3.cdf] 1 -Q BN
Fle Edt View Processng Took Window Hep ) Search altera.com (]
& Hardware Setwp...| Mo Hardware Mode: [ITAG v Progress:
[T Enable real-time ISP to MAX I and MAX V devices)
% Fie Device Checksun  Usercode  Program/  Venfy Bk~ Examine
| e Configure Check.
il stop
@ Auto Detect
X Delete
s, add File..

[ Change File.
| save Fie
Thup

$Down

I oo
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Utilizar 2 displays
Utilize agora as mesmas 4 chaves, mas agora para acionar 2

displays. Cuidado, mudar o nome das variaveis de saida. Como
ficaria?

30
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(manual do PLD D2-115)

Sistema% Digitais: Principios e
Aplicacoes — TOCCI, 112,
edicao, 2011.
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